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Turn Off Notifications  
 

• Select the File menu and choose Options 

• In the left area that lists the various categories, select Mail 

• In the Message Arrival section, beneath When new items arrive in my Inbox, 

uncheck all the checkboxes (no sounds, no notifications, no alerts!) 

• Save 

 
Effective Outlook Notification and Reminder Settings Video Tutorial ▷ 

 
Conversation View 
 
View - Conversations - Show as Conversations 

 

 

Conversation and From Views for Cleaner Inboxes Video Tutorial ▷ 
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Working Offline 
 
• Working offline is a great way to focus on what’s in your inbox without getting 

distracted by incoming messages. 

• When you wish to sync and send, select work offline, let your emails sync, send, 

and download, then select work offline again to focus on the emails that are in 

your inbox.  

 

 
 
 

Folder Structure 
 
Consolidating folders 

 
To consolidate folders, open a folder, click Control A to highlight all items, and then 

right click to Move to the new folder.  

 

Favorite folders 

 
To keep your most-used folders at the top of your list, right click on them and Add to 

Favorites. When you are no longer using that folder because the project isn’t active, 

remove it from your favorites. 
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Rules 

Use Rules to auto-filter notifications or updates you don’t need to see, but want 

access. 

• Right click on an email. 

• Click Create Rule 

• Select From and type in the name or a subject for the message. 

• Select the folder you want it to go to – Archives, Trash, Client Name, 

etc. 

• Click Create Rule. 

•  Don’t click Ok yet! Select Run this rule now on messages already in 

Inbox.  

 

Rules for Auto Filing Video Tutorial ▷ 
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Automating emails from a specific sender into a folder 
 

1. Open the email from the sender 

2. Right click and select Rules - Move - Always Move Messages 

From (SENDER) 

3. Highlight the desired target folder 

4. Click Ok. 
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1. In the mail window, select a folder (or Inbox), click the View tab, 

and then click View Settings in the Current Settings group. 

2. Click Conditional Formatting in the resulting Advanced View Settings dialog 

box. 

3. Click Add and give the new "rule" a name - such as The Boss. 

4. Click the Font button, choose a color from the Color dropdown (pick one that 

is easy on the eyes), and click OK. 

5. Click Condition and then click From. 

6. Find the contact, double-click it to add it to the From condition, and 

click OK four times. (If creating a rule for messages sent, make sure 

you add the name to the Sent To control.) 

Outlook will display existing messages from the designated contact in 

the assigned color. It will also show new incoming messages in that color 

as they arrive. 
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If the contact isn't in your Address Book, you can enter the contact's 

email address. 

The name you're matching must exactly match the name Outlook displays 

in the From.  

You can't use the same rule to assign a color to messages from and 

sent, even though the dialogs offer both options and will even let you 

specify both in the same rule. 

 

Conditional formatting rules apply only to the current folder, but you 

can add the same rule to multiple folders. Always start by selecting the 

right mail folder (#1). 

 

Only add colors for 2-3 people or projects, or you will get too many colors and 
will ignore them. 
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Creating a Rule for Color Video Tutorial ▷ 
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Ignoring Conversations 
 
 
When you get stuck on an email chain of congratulations, announcements, or 

anything else you don’t want, choose to ignore the thread by selecting the 

email and clicking Ignore. Future emails from that thread will go to your 

deleted folder rather than clutter up your inbox. 

 

If you change your mind, you can go to the email in your Deleted Items folder, 

select it and click the Ignore button again to disable it. 

 

Ignoring Conversation  Video Tutorial ▷ 
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Tasking 
 
Quick Step for Tasking 

 
Don’t use your inbox as your task list! You can't prioritize, and you have to look 

at what you need to do repeatedly. For team projects, I recommend using a 

project management task system like Planner, Asana, or ClickUp, and not 

delegating through email You can use Planner, ToDoist, or the native Outlook 

for personal tasks if you have simple tasking to perform. I do not recommend 

creating flags. Again, you can’t prioritize by date, it stays in the Inbox, and 

most people end up having hundreds of red flags they never clear out. 
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You can take extra action to delete the message. If you like to put everything in files, 
select Always ask for folder, to it is saved in your task list and your selected folder. 
 

Tasking from Email Video Tutorial ▷ 

 

How to add tasks to an Outlook calendar 
 

1. On your calendar screen, click View 

2. Click Daily Task List 

3. Click Normal. 

4. Drag and drop a task into a calendar item for a specific time.   
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Meeting Request 
 

Turn off meeting request responses. 

In a new meeting request, do the following: 

1. On the Meeting tab, in the Attendees group, click Responses. 

 NOTE: For recurring meetings, the Meeting tab appears as the Recurring 

Meeting tab. 

 

2. Click Request Responses to clear the Request Responses and 

Allow New Time Proposal checkboxes. 

 

NOTE: If you turn off the Request Responses option, you will not be able to track 

whether attendees have accepted, tentatively accepted, or declined. For 

instance, when you open the meeting in your calendar, click the Meeting tab, and 

then click Tracking in the Show group, the Response column will display None for 

all of the attendees. Instead, you could create a rule that meeting responses go 

directly to your archives, trash, or another folder. 

 

Turn off responses after you send the meeting request. 
 

Even if you don't turn off the response option when you initially send the meeting 

request, you can change the option at any time. 

1. Open the meeting. 

2. On the Meeting tab, in the Attendees group, click Responses. 
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NOTE: For recurring meetings, the Meeting tab appears as the Recurring 

Meeting tab. 

3. Click Request Responses to clear the Request Responses and 

Allow New Time Proposal checkboxes. 

4. Click Send Update, so the meeting request updates in Outlook for all meeting 

attendees. 

 

Search folder 
 
There is no reason to scroll up and down your inbox to find an email anymore. If 

you are doing this, you got into the habit with older versions of Outlook. You 

can streamline your searching by going to the Search Folders on the left and 

creating a new Search Folder. Examples could be all your Unread or Follow Up 

or Unread from NAME. 

 

How to Search All Folders in Outlook 
 

This step is only necessary for older versions of Outlook. Create an Outlook Search 

Folder that will search through all of your mail in one step. It will not search inside any 

archived .PST files. 

Create an All Mail Search Folder in Outlook 
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In the folder Navigation list, right click the header that says Search Folders and then 

select New Search Folder. 

Scroll to the bottom of the window and double click where it says Create a custom 

search folder. 

 

 

 

Another window called the Custom Search Folder will open up. Type All Mail Search 

Folder in the Name field box, then click Browse. 
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Now select which folders you want to include in your All Mail Search folder. Uncheck 

the first item, and then check all of the folders you store your most important mail in. 

This will probably be your Inbox, the Sent Items folder, and any others you need to 

include in a global search. Check the box that says Search Subfolders at the bottom. 

Now click OK. 

 

 

 

Click OK. A box will show up saying that you have not specified any criteria. 

Click Yes at this error because you don’t want to create any requirements for 

this. 

 

 

 

Now click OK again, and you should now see the All Mail Search folder in the 
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Search Folder List. It may take some time to load the first time. After it has 

loaded, arrange the folder by Date. 

Search All Folders by Default in Outlook 2010 and 2013 

Set up Outlook to search the items within All Folders by default. 

Click File and then select Options. 

In the Outlook Options window, click Search, choose the All mailboxes option. 

 

 

Click OK. You will now search all folders by default in Outlook 2010 and 2013. 

 

All/Unread vs. Focused/Other 
 

With Focused and Other, you will only get emails from within your organization 

in the focused mailbox and newsletters and emails outside the organization in 

your Other mailbox. This method works well if you mostly communicate 

internally.  

 

Message Templates 
 

Creating an email message template 

 
1. New group - New E-mail. 

2. In the message body, enter the content that you want. 

3. File tab. 
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4. Click Save As. 

5. In the Save as box, click Outlook Template in the Save as type list (do not 

save it to My Documents or some other folder). Type a name for your 

template, and then click Save. 

 

Sending an email message from a template 

 
1. Select New Items (upper left corner) > More Items > Choose Form. 

2. Look In, click User Templates in File System. 

3. The default templates folder is opened 

c:\users\username\appdata\roaming\microsoft\templates. If your template 

is saved in a different folder, click Browse, and find it. 

4. Select the template, and click Open. 

5. You can make changes to the subject and message body. 
 

Note - Changes made aren’t saved to the template. It will create a draft of your 

current message if you save but won’t update the template. 

 

Delay or Schedule Sending Email Messages 
 
You can delay the delivery of an individual message or you can use rules to delay 

the delivery of all messages by having them held in the Outbox for a specified time 

after you click Send. 

 
Delay the delivery of the message 
 

1. While composing a message, select the More options arrow from the Tags 

group in the Ribbon. 
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2. Under Delivery options, select the Do not deliver before check box, and 

then click the delivery date and time you want. 

 

3. Click Close. 

4. When you're done composing your email message, select Send. 

After you click Send, the message remains in the Outbox folder until the delivery 

time.  

If you decide later that you want to send the message immediately, do the 

following: 

1. Switch to the Outbox folder.  

2. Open the delayed message.  

3. Select the More options arrow from the Tags group in the Ribbon.  

 

4. Under Delivery options, clear the Do not deliver before check box.  

5. Click Close and send. 

Note: Outlook must be online and connected for this feature to work. 

Delay the delivery of all messages  
 
You can delay the delivery of all messages by up to two hours by creating a rule.  

1. Click File.  

2. Click Manage Rules & Alerts.  
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3. Click New Rule.  

4. In the Step 1: Select a template box, under Start from a Blank Rule, click 

Apply rule on messages I send, and then click Next.  

5. In the Step 1: Select condition(s) list, select the check boxes for any 

options that you want, and then click Next.  

If you do not select any check boxes, a confirmation dialog box appears. If 

you click Yes, the rule that you are creating is applied to all messages that 

you send.  

6. In the Step 1: Select action(s) list, select the defer delivery by a number 

of minutes check box.  

7. In the Step 2: Edit the rule description (click an underlined value) box, 

click the underlined phrase a number of and enter the number of minutes 

for which you want the messages to be held before it is sent.  

Delivery can be delayed up to 120 minutes.  

8. Click OK, and then click Next.  

9. Select the check boxes for any exceptions that you want.  

10. Click Next.  

11. In the Step 1: Specify a name for this rule box, type a name for the rule.  

12. Select the Turn on this rule check box.  

13. Click Finish.  

 

After you click Send, each message remains in the Outbox folder for the time 

that you specified. 

 

Recall or replace an email message. 

 
With message recall, a message you sent is retrieved from the recipients who haven't 

yet opened it from the mailboxes. You can also substitute a replacement message. 
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For example, suppose you forgot to include an attachment. In that case, you can 

attempt to retract the message and then send a replacement message with the 

attachment. 

 

Message recall is available after you click Send and is available only if both you and 

the recipient have a Microsoft 365 or Microsoft Exchange email account in the same 

organization. 

 

Newer versions 

1. In the folder pane on the left of the Outlook window, choose the Sent 

Items folder. 

2. Open the message that you want to recall. You must double-click to open the 

message. Selecting the message, so it appears in the reading pane, won't allow 

you to recall the message. 

3. From the Message tab, select Actions > Recall This Message. 
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Notes:  

• If you don’t see the Recall This Message command, you probably don’t 

have an Exchange account, or the feature isn’t available within your 

organization. 

• You cannot recall a message that's protected by Azure Information 

Protection. 

• You cannot recall a message in Outlook on the web. 

4. Click Delete unread copies of this message or Delete unread copies and replace 

with a new message, and then click OK. 

5. If you’re sending a replacement message, compose the message, and then 

click Send. 

 
To Enable or Disable Notifications of Completed Print Jobs 
 

1. Click Start, and then click Printers and Faxes. 

2. On the File menu, click Server Properties. 

3. On the Advanced, click the options you want to apply: 

a. Show informational notifications for local printers. This option notifies 

users when a job is printed on a printer that is attached to this 

computer. 
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b. Show informational notifications for network printers. This option 

informs users of this computer when a job is printed on a remote 

computer. 

4. For client computers that are running versions of Windows earlier 

than Microsoft Windows 2000 that access the printers on this 

computer, there are additional configuration options to choose 

from: 

a. Notify when remote documents are printed. This option 

sends a message to the user who sent a job to a printer 

attached to this computer. 

b. Notify computer, not user, when remote documents are 

printed. This option sends a message to the computer from 

which the print job was sent, regardless of which computer 

the sending user is currently logged on. 
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Publishing a Calendar for External Viewing 
 
Suppose you don't have a scheduling system like Acuity, Book Like a Boss, or 

Calendly, and often have meetings with external clients or vendors. In that case, you 

can publish your calendar for external viewing. To make it easy for people to schedule 

with you, provide a hyperlink to your calendar in your signature line, or provide it when 

scheduling meetings. 
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Speed Reading 
 
To read your email faster in Reading Pane view, you can use the space bar to 

move down the message and then go to the next message. Go into Options – 

Mail – Outlook Pane – check Single key reading using space bar.  Only do this if 

your current way of reading isn’t working for you.
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This Outlook Go-To Guide is designed to help you set up your email for maximum 

efficiency and only the beginning of what Outlook can provide. However, the best 

systems and tools mean nothing when the behaviors aren't effective. Start with the 

system and follow with the actions. 

 

 

 

need help with that?  
We're here for you for private and team coaching.  

Contact us at hello@helloraderco.com. 

 

 


